
did you

know?
the Penny is the only coin currently minted in the United States with
a profile that faces to the right. All other U.S. coins feature profiles that
face to the left.

the world’s largest wind generator is on the island of Oahu, Hawaii.
The windmill has two blades 400 feet long on the top of a tower, twenty
stories high.

the only house in England that the Queen may not enter is the House
of Commons, because she is not a commoner. She is also the only
person in England who does not need a license plate on her vehicle.

former U.S. Vice President Al Gore and Oscar-winning actor
Tommy Lee Jones were roommates at Harvard.

Chapter Objectives

• Plan and document a workbook

• Create formulas containing cell references and
mathematical operators (MOUS Ex2002-5-1)

• Write functions including Sum, Average, Max, and Min
(MOUS Ex2002-5-2)

• Use Excel’s AutoSum feature to automatically write Sum
functions

• Learn several ways to copy a formula from one cell to many
other cells

• Differentiate between absolute, mixed, and relative cell
reference (MOUS Ex2002-5-1)

• Adjust column widths (MOUS Ex2002-3-2)

• Set a print area (MOUS Ex2002-3-7)

• Move text, values, and formulas (MOUS Ex2002-1-1)

• Insert and delete rows and columns (MOUS Ex2002-3-2)

• Format cells (MOUS Ex2002-3-1)

• Create cell comments (MOUS Ex2002-7-3)

C H A P T E R

2
two
Planning and
Creating a
Worksheet

haa70313_EXch02.qxd  10/12/01  3:57 PM  Page 2.1



EX 2.2

Each year for 12 years, a group of five California

cities has held a recycling contest to see which city

does the best job of recycling plastic, glass, and

aluminum. Cities participating in this year’s contest

are Arcata, Los Gatos, Pasadena, San Diego, and

Sunnyvale. Mayors of each of the competing cities

elect a contest organizer from a slate of candidates.

Although the Recycling Contest Chairperson posi-

tion is unpaid, it is a great honor to be chairperson.

Many candidates vie for the chairperson’s position.

To avoid any conflict of interest, contest rules

require that the chairperson not be a resident of

any of the competing cities.

This year’s contest chairperson is Kelly Allison.

She is a member of the Los Angeles Chamber of

Commerce and well known in the Los Angeles area

for her work with businesses and the Los Angeles

city council. Because chairing the recycling contest

is more than a part-time job, Kelly has requested a

leave of absence for the contest’s three-month

duration. She will need help from several volun-

teers to carry out various tasks associated with the

contest, to meet with officials from contesting

cities, and to periodically monitor recycling.

This year, the contestants want to recycle alu-

minum cans. To help keep track of each city’s

recycling, Kelly has designated several recycling

collection points in each of the five cities. The num-

ber of recycling centers is proportional to each

city’s population so that no city has to cope with a

recycling congestion problem. Because the popu-

lations of the participating cities are wide ranging,

a large city such as San Diego will probably recycle

the largest number of aluminum cans as its popu-

lation is over 2.8 million people. To make the con-

test fair for both large and small cities, the winning

city will be the one that recycles the largest num-

ber of cans per capita—the number of cans recy-

cled by a city divided by the number of residents of

that city.

Each city has a recycling supervisor who mon-

itors and records that city’s recycling for every

month for the contest’s duration. The first of each

month, the contest supervisors e-mail the recy-

cling numbers to Kelly Allison. Kelly needs your

help to compile the numbers in an Excel worksheet

and create the formulas to compute the total recy-

cling by city each month, total recycling for all

cities each month, and compute the all-important

per capita recycling value that determines the con-

test winner. In addition, Kelly wants to know a few

statistics about the monthly recycling efforts

including the minimum, average, and maximum

number of cans recycled.

Figure 2.1 shows the completed Aluminum

Can Recycling Contest worksheet. You will be

developing the worksheet in this chapter.

chapter case

Intercity Recycling Contest
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INTRODUCTION

Chapter 2 covers writing formulas in worksheet cells, using Excel func-
tions, copying and moving cell contents, and formatting. In this chapter
you will create a new workbook from scratch. First, you will type text to
identify the worksheet’s columns of numbers. You will write expressions
using the Excel functions SUM, MIN, AVERAGE, and MAX. Using Excel’s
AutoSum feature, you will build expressions to total columns by selecting
cell groups and then clicking the AutoSum to automatically build the SUM
function. You will learn to write formulas and then save time by copying
them to other cells in the worksheet to create a family of related formulas.
Chapter 2 describes the differences between using relative, mixed, and
absolute cell references in expressions and the advantages of each form.
You will learn how to use spell-checking to reduce the chances of your
worksheets containing misspellings and how to save your workbook.
Finally, Chapter 2 describes how to adjust a worksheet page’s print settings
such as print margins and the print area.

SESSION 2.1 WRITING FORMULAS, USING
FUNCTIONS, AND COPYING AND MOVING
CELL CONTENTS

In this section, you will learn how to build a worksheet; enter text, formu-
las, and use Excel functions; and copy and paste formulas to create a fam-
ily of related formulas.

CREATING WORKBOOKS
Workbooks that endure are well planned and organized. Workbooks
designed in a haphazard way grow into finished products that are hard to
understand and use. The process from designing a workbook to producing
the final printed result follows a series of steps that increase the likelihood
of a successful finished workbook.

• First, determine the purpose of the workbook and the worksheets it
contains and decide on its overall organization.

CHAPTER OUTLINE

2.1 Writing Formulas,

Using Functions,

and Copying and

Moving Cell

Contents

2.2 Formatting Cells,

Print Setup, and

Printing

2.3 Summary

EXCEL

EX 2.3

F I G U R E  2.1
Completed Can Recycling
Contest worksheet
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• Next, enter text, values, and formulas into the worksheet.

• Then, test the worksheet’s robustness by entering various values
into it and viewing the results.

• Modify formulas that display incorrect results.

• Create documentation such as a description of the worksheet’s pur-
pose, the worksheet author’s name, names and dates of any modifi-
cations, and which cells contain data—the assumptions—and
which are formulas.

• Review and implement appearance changes to render the work-
sheet’s displayed values and text more attractive.

• Save the workbook.

• Print the worksheet and its formulas.

PLANNING A WORKBOOK AND ITS WORKSHEETS Kelly brain-
storms with you about the recycling contest and the structure of the work-
sheet that will record the recycling values reported by contest supervisors.
The worksheet should show in the clearest possible way the following:

• What is the overall purpose of the worksheet?

• What are the important results to display in the worksheet?

• What types of data must the supervisors collect and report back to
Kelly in order to compute the results?

• What formulas and functions create the answers? The answer to
this question specifies the formulas the worksheet designer must
write.

With the preceding questions in mind, Kelly creates a list answering
the questions. Purposefully general, the answers will guide her in design-
ing the worksheet or directing someone else to do so. The following is a list
of specific answers to the preceding worksheet design questions. See
Figure 2.2.

With the list of input data values and formulas that Kelly wants to
appear in the worksheet, she draws a rough sketch. This helps her decide

EX 2.4 CHAPTER 2 EXCEL 2.1 WRITING FORMULAS, USING FUNCTIONS, AND

F I G U R E  2.2
Recycling contest worksheet
planning guide

Objective: 

Produce a worksheet comparing per-capita recycling among cities

Input Data:

1. City names
2. City populations
3. Recycling amounts by city for each of the three months

Calculated Results (formulas):

• Per capita recycling for each city
• Total recycling per month for all cities
• Smallest recycling amount for each month
• Average recycling amount for each month
• Maximum recycling amount for each month
• Three-month recycling total for each city
• Grand total recycling for all cities for the entire contest period
• Total revenue generated for all recycled cans
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EXCEL

where totals, labels, and input values look best and allows her to visualize
the worksheet’s design. Figure 2.3 shows her sketch of the finished work-
sheet with x representing values or calculated results.

BUILDING A WORKSHEET
Using Kelly’s worksheet planning guide (Figure 2.2) and her hand-drawn
sketch of the layout (Figure 2.3), you proceed to create the worksheet.

Starting Microsoft Excel:

1. Start Excel by clicking Start, pointing to Programs, and click-
ing Microsoft Excel

2. Place your floppy disk in the floppy disk drive so that you can
save the worksheet later

3. Ensure that both Excel and the empty worksheet are
maximized

Entering Text

Frequently, people begin building a worksheet by entering most or all of
the text (labels). With labels in place, the worksheet has a guide indicating
where to place values and formulas. It is a good idea to enter row and col-
umn labels first. Leave room for spreadsheet titles above the data and text
labels. If you forget to leave space, you can always insert rows and
columns where needed. You recall from Chapter 1 that when you enter a
label that is wider than its cell, the label spills over into one or more cells
to its right. Whenever the adjacent cell is not empty, Excel displays only as
much of the label as fits in the cell. Though the entire label may not be vis-
ible, it is all stored in a single cell. Begin by entering the worksheet title
and column labels.

F I G U R E  2.3
Worksheet sketch
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Typing a worksheet title and column labels:

1. Click cell A1, type Aluminum Can Recycling Contest, and
press Enter

Notice that the title spills over into adjacent cells B1 through C1

2. Click cell A3 and type City

3. Click cell B3 and type Population

4. Enter the remaining column heads as indicated below

tip: When you are entering data in a row, press the right arrow key after
typing a cell’s entry to finalize the contents and move right one cell in the row.
That saves time.

Cell C3: Jan

Cell D3: Feb

Cell E3: Mar

Cell F3: Total

Cell G3: Per Capita

See Figure 2.4.

tip: If you make a mistake typing any cell’s text, select that cell and simply
retype it. For short labels, it is usually faster to retype the text than to edit and
correct mistakes.

This year, five cities are entered in the recycling contest. Kelly wants
you to enter the city names in alphabetical order in a single column. Enter
the city names next.

Entering the names of participating cities:

1. Click cell A4, type Arcata, and press the down arrow key-
board key to move to cell A5

2. Type Los Gatos and press the down arrow keyboard key to
move to cell A6

3. Enter the remaining city names as follows:

Cell A6: Pasadena

Cell A7: San Diego

Cell A8: Sunnyvale

worksheet title

column labels

F I G U R E  2.4
Worksheet with title and column
headings in place
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Next, enter summary statistics labels. They identify the values that will
appear to their right to indicate the sum, smallest, average, and largest
recycling value for each month from the five cities.

Entering summary labels:

1. Click cell A9, and type Total

2. Click cell A10 and type Minimum

3. Click cell A11 and type Average

4. Click cell A12, type Maximum, and press Enter

Figure 2.5 shows the worksheet containing the labels you just
typed.

Entering Values

With a little Web research, Kelly has gotten accurate population data for
each of the cities entered in the recycling contest. In addition, the recycling
data arrived in Kelly’s office and she wants you to enter both the popula-
tion data and three month’s recycling values into the worksheet.
Throughout the data entry process, be sure to type the number zero and
the number 1 and not the letter o (“oh”) or the letter l (“ell”).

Entering population and recycling values:

1. Click cell B4 and type 15855

2. Click cell B5, type 28951, and press Enter

3. Enter the remaining population values as follows, pressing
Enter after each entry:

Cell B6: 142547

Cell B7: 2801561

Cell B8: 1689908

4. Click cell C4, type 10505, which is the number of cans that
Arcata recycled in January, and press the down arrow key-
board key

F I G U R E  2.5
Worksheet with all labels
entered
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5. Continue entering the recycling values as follows. (Press Enter
or the down arrow key to move down the column to the next
cell after each typing each entry)

Cell C5: 24567

Cell C6: 102376

Cell C7: 2714664

Cell C8: 1523665

6. Click cell D4, type 24556, and press Enter

7. Continue entering the recycling values for February as follows
(press Enter after typing each value):

Cell D5: 21777

Cell D6: 105876

Cell D7: 2503344

Cell D8: 1487660

8. Click cell E4, type 12567, press Enter, and then continue
entering the recycling values for March as follows (press Enter
after typing each value):

Cell E5: 26719

Cell E6: 121987

Cell E7: 1999877

Cell E8: 1002545

Figure 2.6 shows the worksheet with the Population and three
months’ recycling values entered.

Saving Your Worksheet

Once you have invested more than 30 minutes or so developing a work-
sheet, especially a new one, you should save it—even if you haven’t com-
pleted it. More times than you can believe, nearly completed worksheets

city
population
values

monthly recycling
values for each city

F I G U R E  2.6
Worksheet with completed
population and recycling values
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are lost due to power failures, computer glitches, or other mistakes.
Because you created the worksheet from scratch, you do not have a back-
up copy stored safely on disk. Now is a good time to do save it.

Saving your worksheet:

1. Click File, and then click Save As. The Save As dialog box
appears

2. Using the Save in list box at the top of the Save As dialog box,
navigate to the disk drive and folder where you want to store
your workbook

3. Type Recycle in the File name text box to change the work-
book’s name

4. Click the Save As dialog box Save button to save the file. The
new name appears in the Excel Title bar

Now you have a backup copy safely stored on your floppy disk. If
something would happen to reset the computer on which you are working,
then you can use the Recycle.xls worksheet you stored on disk as the
starting point to rebuild any lost work.

WRITING FORMULAS
Now you have the fundamental recycling data on which you can base for-
mulas that compute the results. Among the first results that Kelly wants
you to create are the formulas that display each month’s minimum, aver-
age, and maximum recycling values. The first formula Kelly would like you
to write is one to total each month’s recycling values.

Creating Excel Sums Automatically

The most frequently used Excel function is SUM. It totals one or more
cells. Because the SUM function is so popular, Excel provides the AutoSum
button on the Standard toolbar. When you click the AutoSum button,
Excel creates a SUM function, complete with a proposed range of cells to
be totaled. Excel makes assumptions about which group of contiguous
cells you want to total and creates a SUM function based on cells adjacent
to the current active cell. You accept Excel’s proposed cell range by press-
ing Enter, or you can select a different range of cells by using arrow keys or
the mouse.

task reference
Writing Formulas

• Select the cell to contain a formula

• Type �

• Type the remainder of the formula

• Press Enter or press an arrow key to complete the entry and move to
another cell
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Next, you will use the AutoSum button to create a SUM function to
total the recycling values for January.

Calculating the number of cans recycled
in January:

1. Click cell C9, the cell to contain the total cans recycled in
January

2. Click the AutoSum button on the Standard toolbar. Excel
creates a SUM function in cell C9 and suggests a cell range to
sum by placing a dashed line around the cell range C4:C8 (see
Figure 2.7). That is the correct cell range. Figures 2.6 and 2.7
show the worksheet with the Population and three months’
recycling values entered.

3. Press Enter to complete the formula. The result, 4375777,
appears in cell C9

Using the same approach, create the remaining two sums. Notice that
Kelly did not ask you to total population for the five cities because the total
population is not a meaningful value in this application.

Entering formulas to calculate the number
of cans recycled in February and March:

1. Click cell D9, the cell to contain the total cans recycled in
February

AutoSum button

sum cell range appears
between parentheses

suggested cell range
to sum is enclosed in
a dashed rectangle

SUM function that
AutoSum builds

F I G U R E  2.7
Using AutoSum to build a SUM
formula
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2. Click the AutoSum button on the Standard toolbar. Excel
creates the appropriate SUM function in cell D9

3. Press Enter to complete the formula. The result, 4143213,
appears in cell D9

tip: If the sum your worksheet displays for column D does not match the
preceding value, be sure to check the values in cells D4 through D8 to make
sure they match the values shown in Figure 2.7

4. Click cell E9, the cell to contain the total cans recycled in
March

5. Click the AutoSum button. Excel creates the appropriate SUM
function in cell E9

6. Press Enter to complete the formula. The result, 3163695,
appears in cell E9

Modifying AutoSum-Suggested Cell Ranges

Each city’s total three-month recycling number is crucial to calculating
which city wins the contest. Kelly asks you to enter formulas to total each
city’s recycling and to create a grand total that is the number of total cans
recycled by all cities for three months. Each city’s total and the grand total
recycling numbers will appear in column F, headed by the column label
Total.

Create the row totals for each city next.

anotherword

. . . on quickly viewing the sum of a selected cell range

If you select a range of cells, their sum appears in the status bar located at
the bottom of the worksheet. Selecting a range provides you a quick view of
the sum without writing a SUM function in the worksheet.

task reference
Modifying an AutoSum Cell Range by Pointing

• With the AutoSum cell range outlined, press an arrow key repeatedly to
outline the leftmost or topmost cell in the range through to the desired
starting cell of the range

• Press and hold the Shift key

• Press the right or down arrow key repeatedly to move right or down
until reaching the last cell in the cell range

• Release the Shift key

• Press Enter to complete the AutoSum formula
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Creating a row total for each city with
AutoSum and changing the summed
cell range:

1. Click cell F4, the cell to contain the total cans recycled by
Arcata

2. Click the AutoSum button. Excel suggests summing the cell
range B4:E4. Because cell B4 is Arcata’s population, you will
exclude it from the sum in the next steps

3. Press the right arrow key to move the outline to cell C4 (see
Figure 2.8)

4. Press and hold the Shift key

5. Press the right arrow key twice to outline the cell range C4:E4

6. Release the Shift key

7. Press Enter to finalize the formula. The value 47628 appears in
cell F4, along with a cell error Smart Tag symbol that appears
in the upper-left corner of the cell. The Smart Tag warns that
the sum range has omitted a value adjacent to it. That’s okay

You can ask Excel to create more than one SUM function at a time by
selecting rows or columns of values with an empty adjacent column or row
(respectively) in the range of cells. Then you click the AutoSum button to
have Excel build multiple sum functions in one operation.

Creating multiple sum functions at once:

1. Click cell C5 and drag the mouse through cell F8 to select the
cell range C5:F8

2. Click the AutoSum button. Excel automatically creates sum
functions in the cell range F5:F8. Additional cell error Smart
Tags appear in the cell range F5:F8.

3. View a Smart Tag by clicking cell F5 and then hovering the
mouse over the Smart Tag icon. A warning message appears
stating “The formula in this cell refers to a range that has addi-
tional numbers adjacent to it.”(see Figure 2.9)

partially complete
SUM formula

outline indicates cell selected by pointingF I G U R E  2.8
Changing the beginning cell in an
AutoSum cell range
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Finally, Kelly asks you to write a formula for the grand total—the total
number of cans the five cities recycled the during the three-month contest.
You do that next.

Creating a grand total formula:

1. Select cell F9, and then click the AutoSum button. Excel sug-
gests the sum range F4:F8

2. Press Enter to accept the suggested cell range and complete
the SUM formula. The grand total value 11682685 appears in
cell F9. This means that the cities involved have recycled
nearly 12 million cans (see Figure 2.10)

The cell error indicators in cells F4 through F8 are distracting to Kelly
and she asks you to remove them.

Smart Tag cell error Smart Tag indicator

Smart Tag warning message

F I G U R E  2.9
Smart Tag and warning message

anotherword

. . . about Smart Tags

Microsoft Office Smart Tags are a set of buttons that are shared across the
Office applications. The buttons appear when needed, such as when Excel
detects you may have made an error in an Excel formula, and gives the user
appropriate options to change the given action or error.

grand total

F I G U R E  2.10
Worksheet with row totals and
grand total
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Removing cell error indicators from cells:

1. Select the cell range F4:F8

2. Hover the mouse over the Smart Tag, then click the Smart
Tag list arrow to open the list of choices

3. Click Ignore Error in the list of choices displayed in the Smart
Tag list. Excel removes the cell error indicators from all select-
ed cells

4. Click any cell to deselect the cell range

Using Mathematical Operators

Excel formulas begin with an equal sign (�) and are followed by a mixture
of cell references, Excel functions, and values mathematically combined
into a meaningful expression. When you type an equal sign, you are sig-
naling to Excel that you are writing a formula, not a label or a value. For
example, you recall that Excel recognizes 11/22/02 as a value—the date
November 22, 2002. However, if you type �11/22/02, Excel knows you are
entering a formula that instructs Excel to divide 11 by 22 and divide that
result by 02. Excel computes and displays the result, 0.25.

The divide sign (/) is one of several mathematical operators. A mathe-
matical operator is a symbol that represents an arithmetic operation.
When several mathematical operators occur in a formula, Excel employs
the widely recognized precedence order to determine the order in which
to calculate each part of the formula—which mathematical operators to
evaluate first, which to evaluate second, and so on. If a formula contains
more than one operator, the order of precedence determines which opera-
tions to perform first. For example, Excel evaluates the formula
�A1/(B1�B2)*C1^D1 following the precedence order rules. First, Excel
computes the value of B1�B2, because that expression is inside parenthe-
ses and saves the result temporarily. Then, Excel computes C1^D1, which
is the value in cell C1 raised to the power in cell D1 power, and temporari-
ly saves that partial result. When the remaining operators are all of equal
precedence, Excel evaluates an expression left to right. Therefore, Excel
divides A1 by the value derived earlier for B1�B2. Finally, Excel multiplies
the previous partial result, A1/(B1�B2), by the temporarily saved value of
C1^D1. For example, the result of the formula �20�2*5�15/3 is 25.
Because multiplication and division have precedence over either subtrac-
tion or addition, Excel computes 2*5 first, which is 10. Then, Excel com-
putes the value of 15/3—the value is 5. The final expression, with the
preceding partial results plugged in, is �20�10�5—the value is 25.

Whenever Excel encounters an expression in which all operators are of
equal precedence, it evaluates the expression left to right. For instance,
Excel proceeds left to right forming the value of the expression �10*5/2*4,
whose evaluation yields 100. Similarly, Excel evaluates the formula
�89�A4�B6�B4 left to right, because the addition and subtraction oper-
ators are of the same precedence, or importance. How would Excel evalu-
ate the expression �9�12/3? Because division is higher precedence than
addition, Excel first divides 12 by 3 and then adds that result to 9. The
expression’s value is 13, not 7.
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On the other hand, if you wanted Excel to first add 9 and 12 before
dividing the result by 3, you must rewrite the formula as �(9�12)/3. Excel
evaluates expressions enclosed in parentheses first. Thus, Excel divides the
sum of 9 and 12 by 3 to yield the answer 7 in the reformulated expression.
Figure 2.11 shows the Excel mathematical operators in precedence order,
first to last.

Although you may not consider parentheses a mathematical operator,
they alter the normal order of precedence wherever they appear in a for-
mula. Therefore, parentheses have highest precedence—they precede all
other mathematical operators when Excel evaluates a formula. Figure 2.12
shows other examples of formulas, precedence rules, and computed
results. You will write formulas using mathematical operators throughout
the book.

Whichever city recycles the largest number of cans during a given peri-
od is certainly important, but using that measure to determine the recycling
winner would always favor larger cities over smaller ones. You recall that
the winner of the recycling contest is the city that has the highest per capi-
ta recycling. Per capita (per citizen) recycling is simply the total recycling

w w w . m h h e . c o m / i - s e r i e s EX 2.15
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F I G U R E  2.11
Precedence order of
mathematical operators

Precedence Operator Description

1 ( ) Parentheses. Alters the order of evaluation.
Expressions inside parentheses are
evaluated first

2 ^ Exponentiation. Raises to a power

3 / or * Division or multiplication

4 - or + Subtraction or addition

F I G U R E  2.12
Examples of expressions and
precedence rules

Formula Result Precedence Rule

A1 = 30 A2 = 20 A3 = 10

=A3+A2*A1 610.00 Multiplication first followed by addition

=(A3+A2)*A1 900.00 Parentheses force addition to occur first followed by
multiplication

=A3*A2/A1 6.67 Equal precedence among the two operators;
proceed left to right

=A1/A2+A3 11.50 Division higher precedence than addition

=A1/(A2+A3) 1.00 Parentheses force addition to occur before division

=A3/A2*A1 15.00 Equal precedence among the two operators;
proceed left to right

=A1+A2-A3 40.00 Equal precedence among the two operators;
proceed left to right
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divided by the city’s population. In this contest, the judges compute that
number for each city by dividing the city’s number of cans recycled in three
months by their population. You build that formula next.

Writing Arcata’s per capita recycling
formula:

1. Select cell G4 to make it the active cell

2. Type �F4/B4 and then press Enter to complete the formula.
The value 3.003974 appears in cell G4. In other words, Arcata’s
recycling amounted to slightly over three cans per person for
every person living in the city

While it seems natural to write the remaining Per Capita formulas for
the remaining cities, you have a feeling that there may be a better way.
You’ve heard Kelly mention that you can copy formulas that belong to a
family of similar formulas, so you wait until you have a chance to talk to
her before writing the rest of the per capita recycling formulas in column G.

USING EXCEL FUNCTIONS
Based on Kelly’s Recycling Contest Worksheet Planning Guide (Figure 2.2),
you need to write formulas to produce statistics for each month. To enter
these statistics, you will use three of the Excel functions that are in the
same group of functions as the SUM function. The group, called statistical
functions, contains several functions including AVERAGE, MAX, and MIN.

An Excel function, you recall from Chapter 1, is a built-in or prere-
corded formula that provides a shortcut for complex calculations. Excel
functions compute answers, such as the average or maximum, using soft-
ware instructions that are hidden from view and, frankly, of little interest.
Excel has hundreds of functions ranging from a function to generate a ran-
dom number to a function to compute the monthly payment for a particu-
lar loan amount. Excel functions are organized in categories containing
related functions. The categories include Database, Date & Time, Engi-
neering, Financial, Information, Logical, Lookup & Reference, Math &
Trig, Statistical, and Text.

Functions are written in a particular way. Rules governing the way you
write Excel functions are called the function’s syntax. Syntax rules include
properly spelling the function’s name, whether or not the function has
arguments, and the order in which you list the function’s arguments. A
function’s argument list is data that a function requires to compute an
answer, and individual list entries are separated by commas. The entire
argument list is enclosed in parentheses and follows the function name
with no intervening space.

For example, the function SUM(A1, C8:C20, 43.8) contains three argu-
ments in the argument list: a cell reference (A1), a cell range (C8:C20), and
a value (43.8). You can write the function name in uppercase, lowercase, or
a mixture. Excel converts the function name to uppercase after you enter
the complete formula and move to another cell. The general form of an
Excel function is this:

Function name(argument1, argument2, . . . , argumentn)
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A function’s name describes what action the function takes. AVER-
AGE, for example, computes the mean of all arguments in its argument
list. The function’s arguments, which specify the values that the function
uses to compute an answer, can be values, cell references, expressions,
functions, or an arbitrarily complex combination of the preceding that
results in a value.

You can enter functions into a cell alone or enter functions as part of a
larger expression either by typing the function or by using the Paste
Function button located on the Standard toolbar. The Paste Function but-
ton opens a dialog box in which you can simply point to the arguments to
include in the function, click OK, and let Excel build the complete, syntac-
tically correct function complete with argument list.

MIN Function

MIN is a statistical function that determines the minimum, or smallest val-
ue, of all the cells and values in its argument list. It is useful for determin-
ing, for example, the lowest temperature from a long list of temperatures
or finding the lowest golf score from 800 players’ scores. The function is
written this way:

MIN(argument1, argument2, . . . ,argumentn)
Often workbook creators write the MIN functions with only one argu-

ment—a cell range that Excel examines to determine the smallest value.
You must specify multiple arguments when you cannot specify the cells in
one cell range. For example, to find the smallest value of those in cells A1,
A2, A3, B4, B5, C4, and C5, you must write two arguments, one for each
cell range:

MIN(A1:A3, B4:C6)
Like other statistical functions, MIN ignores empty cells and cells contain-
ing text when computing its answer.

Kelly wants you to write the MIN function to produce the smallest
recycling value for January.

w w w . m h h e . c o m / i - s e r i e s EX 2.17
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task reference
Writing a Function Using the Paste Function Button

• Click the cell to contain the function

• Click the Standard toolbar Paste Function button to open the
Paste Function dialog box

• Click the Function category of the function type you want

• Scroll the Function name list, if necessary, to locate the function you
want

• Click the function you want in the Function name list box

• Click OK to open another dialog box

• Enter information in the edit boxes for each argument

• Click OK to close the dialog box and complete building the function in
the selected cell
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Building a MIN function using the Paste
Function button:

1. Ensure that Excel is running and that the Recycle workbook is
loaded

2. Select cell C10, the cell in which you want the MIN function
built

3. Click Insert on the menu bar, click Function, and then click
the Or select a category list arrow. A list of available func-
tion categories appears

4. Click Statistical in the Or select a category list to choose the
category containing the MIN function

5. Drag the Select a function scroll box until you locate MIN
in the alphabetically sorted list of statistical functions

6. Click MIN in the Select a function list. Figure 2.13 shows the
MIN function syntax in the Insert Function dialog box. A brief
description appears there also

7. Click the OK button to open the Function Arguments dialog
box. Two text boxes appear, one for each of two arguments.
The dialog box also displays a description of the function, a
description of the argument list, the current values of the argu-
ments, the current results of the function, and a model of the
entire formula. Notice that Excel suggests the cell range C4:C9
for Argument1. That is not the correct cell range, so you will
correct it next (see Figure 2.14)

list of function categories
available in the list box

MIN function syntax

MIN function description

some of the 
statistical functions

Select a function list
scroll box

F I G U R E  2.13
Insert Function dialog box

description of
the function
and its
arguments

current value of the 
formula comtaining 
the function

collapse/expand dialog box button

partial list of function
arguments

function's current value

F I G U R E  2.14
The Function Arguments
dialog box
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8. Click the Collapse Dialog Box button appearing to the
right of the Number1 text box. The Function Arguments dialog
box collapses to its title bar, making it easier for you to locate
and point to the correct cell range

9. Click the Function Arguments dialog box title bar and
drag it to the right so that you can see cells C3 through C9

10. Click and drag the cell range C4:C8. Notice that as you are
dragging the cell range, the ScreenTip 5R x 1C appears, indi-
cating you have selected five rows and one column

11. Click the Expand Dialog Box button to restore the collapsed
dialog box. Notice that the correct range, C4:C8, appears in the
Number1 text box, and the minimum value 10505 appears
near the bottom of the dialog box next to the text “Formula
result �”

12. Click the OK button to accept the MIN formula that Excel built
for you and return to the worksheet. The minimum value of
the selected range, 10505, appears in cell C10

Based on Kelly’s plan, you need to enter two more functions to com-
plete January’s statistical information. These functions yet to be added to
the worksheet are AVERAGE and MAX.

AVERAGE Function

AVERAGE is a statistical function that determines the average (arithmetic
mean) of all the cells and values in its argument list. It is useful for deter-
mining, for example, the average grade of all students taking a test (empty
cells or cells with labels are ignored), determining the average price of a
stock from a list of weekly closing prices, or computing the average rain-
fall for the year. The function is written this way:

AVERAGE(argument1, argument2, . . . ,argumentn)
It is common to see an AVERAGE function with one argument—a cell
range—that Excel examines to calculate the average value of the range of
values. Similar to other statistical functions, AVERAGE can have up to 30
arguments separated by commas in its argument list.

Kelly wants you to use the AVERAGE function to compute and display
the average number of cans recycled each month. You begin by writing an
AVERAGE function to determine the average number of cans recycled in
January.

Writing an AVERAGE function:

1. Click cell C11, if necessary, to make it the active cell

2. Type �AVERAGE(C4:C8) and then press Enter. Cell C10
displays 875155.4, the average number of cans recycled in
January by all five cities

ex501
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The last statistical value you need is the maximum number of cans
recycled in January. For that formula, you will use the MAX function.

MAX Function

MAX is a statistical function that determines the largest number. MAX can
seek out, for example, the highest-priced real estate from a list of sale
prices, the highest examination score, or the largest stock price gain over a
time period. The function is written this way:

MAX(argument1, argument2, . . . ,argumentn)
MAX, like the other statistical functions, can have up to 30 arguments sep-
arated by commas. Arguments can be values, cell references, cell ranges,
or arbitrarily complex formulas that calculate a numeric value.

Kelly wants you to write a MAX function to compute and display the
value for the largest number of cans recycled in January.

Writing a MAX function by pointing to
designate cell ranges:

1. Click cell C12, if necessary, to make it the active cell, because
that cell will contain the formula displaying the maximum
number of cans recycled in January

2. Type =MAX( to start the formula

3. Move the mouse pointer to cell C4, and then click and drag
the mouse to select cells C4 through C8. A dashed line indi-
cates the cells you have selected as you drag the mouse

4. Release the left mouse button and press Enter. Excel com-
pletes the formula and displays the value 2714664, the largest
value in the specified cell range. Notice that Excel automati-
cally adds the terminating right parenthesis when you press
Enter. Figure 2.15 shows the worksheet with the three statisti-
cal functions displaying January’s recycling results

COPYING FORMULAS TO SAVE TIME
Worksheets often contain expressions that are repeated across a row, down
a column, or both. Although such expressions may consist of the same
mathematical operators and functions, any cell references within formulas

fill handle

statisical
functions for 
January recycling

F I G U R E  2.15
January’s statistical functions
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are slightly different. Whenever you identify families of expressions—for-
mulas that are identical with the exception of their cell references—avoid
creating each expression individually. That approach is time consuming
and unnecessary. Instead, take advantage of Excel’s ability to create copies
of formulas. Examples of functions that you can clone to save time are the
MIN, AVERAGE, and MAX. While you could recreate these three formulas
manually for the February and March, Excel can do the same job much
more quickly.

The key to when you can copy existing formulas is to create a series of
formulas. Similarly, you can create four more per capita formulas, or you
can copy the existing per capita recycling formula you created for Arcata
to the other cities. Unlike a copy operation that Word carries out, Excel
copies formulas and then adjusts all cell references in the copied formulas.
You can choose to copy one cell’s contents (a formula, value, or text) to
another cell, you can copy one cell’s contents to many cells, or you can
copy many cells’ contents to an equal-sized many-cell group. The copied
cell(s) are called the source cell(s), and the cell or cells to which the con-
tents are copied are known as target cell(s).

There are several equally convenient ways to copy a cell’s contents to
other cells. You can copy a cell’s contents using Excel menu commands, a
cell’s fill handle, or toolbar buttons. A cell’s fill handle is the small black
square in the lower-right corner of the active cell (see Figure 2.15).

Copying Formulas Using Copy/Paste

You can copy the contents of one or more cells by copying the cell or
cell range to the Clipboard and then pasting the copy into one or more
cells in the same worksheet or in a different worksheet. When you copy
one or more cells, Excel surrounds the copied cell or cells with a dashed
line, or marquee, to indicate the Clipboard’s contents. Pressing the Escape
key empties the clipboard and removes the dashed line surrounding the
copied cells.

The worksheet’s plan calls for the cell formula �F5/B5 in cell G5 rep-
resenting Los Gatos’ recycling, �F6/B6 for Pasadena, �F7/B7 for San
Diego, and �F8/B8 for Sunnyvale. Rather than create each of those per
capita recycling formulas, you can copy the formula in cell G4 to cells G5
through G8. Excel will create a copy of the source cell’s contents in each of
the target cells and make slight changes to the cell references in the new
copied formulas.

w w w . m h h e . c o m / i - s e r i e s EX 2.21
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task reference
Copying and Pasting a Cell or Range of Cells

• Select the cell or cells to copy

• Click the Edit menu Copy command

• Select the target cell range into which you want to copy the source
cell’s contents

• Click the Edit menu Paste command
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Copying a formula from one cell to
many cells:

1. Click cell G4 to make it the active cell. The cell’s formula,
�F4/B4, appears in the formula bar

2. Click Edit on the menu bar and then click Copy to copy the
cell’s contents to the Clipboard. Notice that a dashed line
encloses the cell whose contents are on the Clipboard

tip: You can press Ctrl+C instead of using the Edit menu Copy command.
Those of you who keep your hands on the keyboard may favor this keyboard
shortcut.

3. Click and drag cells G5 through G8 to select them. They
are the target range into which you will paste the cell G4’s
contents

4. Click Edit on the menu bar and then click Paste. Excel copies
the Clipboard’s contents into each of the cells in the selected
range and then adjusts each cell’s formula to correspond to its
new location. Notice that the Paste Options Smart Tag appears
below and to the right of cell G8 (see Figure 2.16). The Paste
Options Smart Tag provides several formatting and copying
options in its list. You can access the options by clicking the
Smart Tag list arrow

tip: You can press Ctrl+V instead of using the Edit menu Paste command to
paste the Clipboard’s contents. This may be a faster alternative.

5. Press Escape to clear the Clipboard and remove the dashed
line from the source cell. Click any cell to deselect the range
and view the formulas’ results

If you click any cell in the range of cells you just copied, you will see
that Excel has made changes to the copied formula. Cell G6 contains the
formula �F6/B6. Similarly, Cell G8 contains �F8/B8. The changed cell ref-
erence reflects each copied formula’s new location compared to the original
source cell. For example, cell G8’s formula is exactly four rows higher than
the source in cell G4. Excel adds four to the row portion of each cell refer-
ence to account for its new location four rows higher than the original.

Paste Options
Smart Tag

copied
cells

F I G U R E  2.16
Copied formulas’ results
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Cell reference such as the preceding ones are called relative cell refer-
ences. Relative cell references in formulas always change when Excel
copies them to another location. When you copy a function or formula
horizontally, Excel changes the column letters automatically while leaving
the row number unchanged. When you copy a formula or function verti-
cally, the column letters will stay the same, but Excel changes the row
numbers automatically. If this did not happen, then copying worksheet
cells would merely clone the same values throughout the target range, an
activity that would not save you any time.

Copying Formulas Using the Fill Handle

Sometimes you may find it more convenient and quicker to copy a cell’s
contents by dragging its fill handle. When target cells are adjacent to the
source cell, using the fill handle saves time because you do not have to
click menus and commands to accomplish the copy and paste operations.

You want to make a copy of the three statistical formulas summarizing
January recycling to the other two months creating six new formulas.

Copying several formulas at once:

1. Click cell C10 and drag through cell C12 and release the
mouse to select the three cells containing statistical formulas
for January

2 Move the mouse pointer over the fill handle in the lower-right
corner of cell C12 until the pointer changes to a thin plus sign

3. Click and drag the mouse to the right to outline cells D10
through E12. See Figure 2.17

4. Release the mouse button to complete the copy operation.
Excel copies the three formulas from cells C10 through C12
(noted as C10:C12) to cells D10 through E12 and displays the
AutoFill Options Smart Tag

5. Click any cell to deselect the range. Figure 2.18 shows the
results after copying the statistical functions

task reference
Copying Cell Contents Using a Cell’s Fill Handle

• Select the cell whose contents—value, formula, or text—that you want
to copy. If you want to copy a group of cells, select the cell range you
want to copy

• Create an outline of the target cells by clicking and dragging the fill
handle of the source cells to the target cells where you want the copied
contents to appear

• Release the mouse button
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Creating and Copying a Revenue Formula

Kelly wants an estimate of the total value of the aluminum cans recycled
during the contest. Although prices paid at recycling centers vary by city,
the average is two cents per can. So, Kelly would like you to add a formula
to calculate the total value of the recycled cans for each month, placing
those formulas below the maximum statistic for each month. Next, you
will create a label to identify the row displaying the approximate value of
the recycled cans and a label to identify the value per can.

Adding text and a value for the
approximate value of each recycled can:

1. Click cell A14, type Potential Revenue, and press Enter

2. Click cell H1, type 0.02, and press the right arrow key to
make cell I1 the active cell. The value 0.02 (two cents) is the
assumed average value per recycled can

3. In cell I1, type per can and then press Enter. The text you
enter identifies the value to its left. The two cells form the
phrase “0.02 per can,” which is self-explanatory

cell contents being copied
target cells receiving copy

F I G U R E  2.17
Dragging the fill handle to copy
cells

Copy Options
Smart Tag

F I G U R E  2.18
Worksheet after copy operation
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Kelly wants you to write a formula for the potential revenue for
January for all cans recycled by the five cities.

Writing the recycling revenue formula:

1. Click cell C14 to make it the active cell

2. Type �C9*H1 and press Enter. The expression is the product
of the total number of cans recycled in January and the
assumed amount per can, 2 cents. Cell C14 displays the result
87515.54. That is, January’s recycling efforts by the five cities
have yielded an approximate value of almost $88,000

You ask Kelly why she wants the value .02 in cell H1. Instead, why not
write the formula �C9*0.02 for January’s potential revenue? She responds
that the value per can is an assumption that she may want to change later
to see the effect on the potential value of the recycled cans. If that assump-
tion were written directly into each formula, what-if analysis would
require editing the revenue formulas, an unnecessary activity if the
assumption is stored in a separate cell.

Next, you will copy the January revenue formula to the right to fill in
formulas for February and March. Then, you will copy a formula to two
other cells and cause errors to occur. By performing this operation, you
will learn how to avoid the problem in other worksheets.

Copying January’s revenue formula using
copy and paste:

1. Click cell C14 to make it the active cell

2. Press Ctrl+C to copy the selected cell’s contents to the
Clipboard

3. Click and drag the cell range D14:E14 and then release the
mouse

4. Press Ctrl+V to paste the formula into the target cell range,
cells D14 through E14. Figure 2.19 shows the results of the
copy operation

copied formulas
containing errors

indicates an error 
may have occurred

F I G U R E  2.19
Worksheet containing errors in
copied formulas

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.25



EX 2.26 CHAPTER 2 EXCEL 2.1 WRITING FORMULAS, USING FUNCTIONS, AND

5. Press Escape to empty the Clipboard and remove the outline
from cell C14

6. Click any cell to deselect the cell range

That did not go as expected. Excel displays an error Smart Tag indi-
cating it has detected an error. Cell D14 displays “#VALUE!” This is a spe-
cial Excel constant called an error value. The constant indicates that
something is wrong with the formula or one of its components. Cell E14
displays “0,” which is not correct either. Whenever you encounter unex-
pected results from a formula, the best action is to examine the cell’s for-
mula carefully to determine the error. You do that next.

Viewing a cell’s contents:

1. Click cell D14 to make it the active cell

2. Press the F2 function key to display the cell’s contents within
the worksheet grid. F2 is called the Edit function key because
you can edit a cell’s contents by first pressing that key and
then changing the cell’s contents. Excel color-keys both the for-
mula and the cells to which the formula refers so that you can
easily see which cells depend on which other cells. Notice that
cell D14 contains the formula �D9/I1. The first cell reference,
D9, is correct because that is February’s recycling total. The
second cell reference, I1, is incorrect. It should be H1 instead

3. Click cell E14 to examine its contents in the formula bar

4. Press the F2 function key to observe how Excel adjusted the
cell references in that formula

5. Press the Escape key to end the Edit operation on cell E14

The formula errors occur because Excel adjusts all cell references in
copied formulas based on their new position relative to the original cell
formula. Occasionally, you alter cell references to avoid the kinds of prob-
lems that have occurred here. The answer to avoiding these problems lies
in understanding three types of cell references: relative, mixed, and
absolute.

Relative, Mixed, and Absolute Cell References

Sometimes, you do not want Excel to adjust all the cell references in a for-
mula that you copy. (Any cell reference you have used so far in this text is
a relative cell reference.) Excel automatically adjusts relative cell refer-
ences to reflect the new location of the copied formulas containing the rel-
ative cell references. That is what Excel did to the revenue formula.

When you want a cell reference to remain unchanged no matter where
the formula containing it is copied, you use an absolute cell reference. You
indicate that a cell reference is absolute by placing a dollar sign ($) before
both the column and row portions of the cell reference. For example, in the
formula �C14/H1, you can make the cell reference to cell H1 absolute by
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rewriting the formula as �C14/$H$1. No matter where
you copy that formula, Excel will not adjust the $H$1 ref-
erence—it remains anchored to cell H1.

A third type of cell reference allows you to specify
that one portion of a cell reference remains fixed while
the other can be adjusted. A mixed cell reference is a cell
reference in which either the column or the row is never
adjusted if the formula containing it is copied to another
location. For example, if you did not want the row to
change in the preceding reference to cell H1, then rewrite
the formula to �C14/H$1. An easy way to remember this
notation is to substitute the word “freeze” for $. Then a
cell reference such as H$1 reads “H freeze 1” and helps
remind you that the row is unchanging when copying the
formula containing the cell reference. The other form of mixed cell refer-
ence is to hold the column portion unchanged, for example, $H1.

To include a dollar sign in a cell reference as you create a formula, type
a dollar sign as you type the cell reference. Alternatively, you can press the
F4 function key when you edit a cell’s contents to cycle through the four
combinations of references for a cell. Figure 2.20 shows examples of rela-
tive, mixed, and absolute cell references.

To correct the problem that showed up in the revenue formulas, the
best course of action is to correct the original source cell and then re-exe-
cute the copy operation. Then both the source cell and the target cells will
have a corrected copy of the formula. You want to change the original rel-
ative-reference revenue formula in cell C14 from �C9/H1 to the formula
�C9/$H1 so that Excel does not adjust the column portion of the reference
to the per can recycling cell, H1, when you copy the formula to cells to the
right of the existing cell.

Altering a relative cell reference to a mixed
reference:

1. Click cell C14 to make it the active cell

2. Press the F2 function key to edit the formula in place. Notice
that each cell reference in the formula is color coded to an out-
line surrounding the referenced cell in the worksheet. Called

F I G U R E  2.20
Relative, mixed, and absolute cell references

Formula Cell reference type

=A43 Relative

=$A43 Mixed

=A$43 Mixed

=$A$43 Absolute

task reference
Changing Relative References to Absolute or
Mixed References

• Double-click the cell containing the formula that you want to edit or
click the cell and then press F2

• Move the insertion point, a vertical bar, to the left of the cell reference
you want to alter

• Press function key F4 repeatedly until the absolute or mixed reference
you want appears

• Press Enter to complete the cell edit procedure
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the Range Finder feature, it helps you locate cells that the for-
mula references. A cell upon which a formula depends is
called a precedent cell

3. Ensure that the cell insertion point is to the right of the multi-
plication operator and next to or within the cell reference H1
by clicking the mouse or using the keyboard arrow keys (see
Figure 2.21)

4. Press the F4 function key three times to change the cell refer-
ence to $H1

tip: If you press F4 too few or too many times, continue pressing it slowly
until the desired reference, $H1, appears

5. Press Enter to complete the formula alteration

Now you can recopy the corrected January recycling revenue cell to
cells D14 and E14, corresponding to February and March.

Copying January’s corrected revenue
formula using copy and paste:

1. Click cell C14 to make it the active cell

2. Press Ctrl+C to copy the selected cell’s contents to the
Clipboard

3. Click and drag the cell range D14:E14 and then release the
mouse

4. Press Ctrl+V to paste the formula into the target cell range,
cells D14 through E14

5. Press Escape to empty the Clipboard and remove the outline
from cell C14

6. Click any cell to deselect the cell range. Figure 2.22 displays
the corrected revenue results

MOVING TEXT, VALUES, AND FORMULAS
When you modify a worksheet, you may want to rearrange some blocks of
cells containing text, values, or formulas so that they appear in other loca-
tions. For example, you might decide that key values should be grouped
together so that they appear in the top of the worksheet. Whatever the rea-
son, you can move information from place to place with little effort. When

insertion point

F I G U R E  2.21
Insertion point while editing a
cell reference
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you move one or more cells, both the contents and the formatting move to
the new location. Unlike copying cells, moving cells involves taking a cell’s
contents and formatting away from its current location and placing them
in a new location.

Formulas are not changed when they are moved. Of course, moving
text or labels does not change their value either. For example, suppose you
moved the formula stored in cell C14 to compute potential revenue for
January, �C9*$H1, to cell C2. After the move operation, cell C14 would be
empty and the formula �C9*$H1 would occupy cell C2. In other words,
Excel does not adjust cell references in the formula that moves. However,
all cells that referenced a moved formula are adjusted. For example, if you
were to move cell H1 containing the value of a single can to H5, any for-
mulas that referenced cell H1 are adjusted to reference cell H5 automati-
cally. That is, moving a cell’s contents causes all dependent cells to adjust
their references to the new location of the moved formula.

There are several ways to move cell contents from one cell to another.
You can use the mouse to drag and drop the contents of a cell or block of
cells, you can cut and paste one or more cells, or you can insert or delete
rows or columns in a worksheet and thus change a cell’s position. (How to
insert and delete rows or columns is described in the next session.)

Kelly would like you to move the four labels in cells A9 through A12 to
the right so that they are closer to the values they identify.
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corrected revenue cells

F I G U R E  2.22
Worksheet with Corrected
revenue formulas

task reference
Moving Cells’ Contents

• Select the cell or cell range that you want to move

• Move the mouse pointer to an edge of the selected range

• When the mouse pointer changes to an arrow, click the edge of the
selected cell or cell range and drag the outline to the destination
location

• Release the mouse
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Moving four labels:

1. Click and drag the mouse through the cell range A9:A12

2. Release the mouse

3. Move the mouse pointer toward an edge of the selected cell
range until the mouse pointer changes from a large plus sign
to a four-headed arrow.

4. Click any edge of the selected cells and drag the outline to the
right so that it surrounds cells B9 through B12 (see Figure 2.23).

5. Release the mouse. Excel moves the cells to their new target
location

6. Click any cell to deselect the cell range

Moving a cell’s contents to another location is a cut action followed by
a paste action. Cutting removes the cell’s contents from its current location
and places it on the Clipboard temporarily. Pasting moves the Clipboard
contents to the new location. Of course, you can move any block of cells in
one operation, regardless of its size. If the destination cell or cell range
already contains information, Excel issues a warning and asks you if it is
okay to overwrite existing contents. Clicking OK approves overwriting cell
contents, while clicking the Cancel button calls off the attempted move
operation.

RENAMING A WORKSHEET
A handy way to add documentation to a worksheet is to name the sheet in
a meaningful way to reflect its contents. Examine the leftmost sheet tab in
the recycling workbook you created. Notice the sheet tab is labeled Sheet1,
which is the name Excel automatically assigns to the first sheet in a work-
book. If your workbook has other worksheets, they are named Sheet2,
Sheet3, and so on. (The number of worksheets Excel creates when creating
a new workbook depends on how Excel is set up on your computer.)
Because your worksheet is nearly complete, you will give it a name that
reflects its contents.

selected cells
being moved

outline indicates 
cell block destination

indicates current destination cell range

F I G U R E  2.23
Moving cells’ contents

anotherway

. . . to move cells’
contents

Drag the mouse across
the source cell or cell
range you want to move

Click the Cut command
in the Edit menu

Drag the mouse across
the target cell or cell
range to which the
contents will move

Click the Paste
command in the Edit
menu
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Renaming a worksheet:

1. Double-click the Sheet1 sheet tab to select it

2. Type Recycling Contest to replace the current name, Sheet1

3. Press Enter to complete the worksheet renaming operation.
The sheet tab displays the name “Recycling Contest”

SPELL-CHECKING A WORKSHEET
Excel contains a spell-check feature that helps you locate spelling mistakes
and suggests corrections. Comparing words in Excel’s dictionary to the
words in your worksheet, Excel finds words that appear to be misspelled
and suggests one or more corrections. You can choose to leave unchanged
each word Excel locates, or you can select an alternative spelling. You
should always spell-check your worksheet before presenting it to others. It
is easy to overlook misspelled words in any document, and this is espe-
cially true for worksheets.

Kelly knows that a lot of people will see the recycling contest work-
sheet. She wants to make sure that any misspellings in the worksheet are
corrected. She asks you to check the worksheet for spelling mistakes.

Checking a worksheet’s spelling:

1. Click cell A1 to begin-spell checking at the top of the work-
sheet

2. Click Tools on the menu bar and then click Spelling to start
the spell-check operation

tip: you can click the Spelling button on the Standard toolbar to check
spelling

3. Correct any misspellings. A message box opens when all
spelling is correct

4. Click OK to close the message box

task reference
Spell-Checking a Worksheet

• Click cell A1 to begin spell-checking from the top of a worksheet

• Click the Spelling command in the Tools menu or click the Spelling
button on the Standard toolbar

• Choose to correct misspelled words that the spell-checker identifies

• Click OK to close the dialog box
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SAVING YOUR MODIFIED WORKBOOK
You have made many changes to your worksheet. It is time to save your
work permanently on your disk so that you have a portable copy and to
preserve it for future use.

Saving your worksheet under its current
name:

1. Click File

2. Click Save. Excel saves the worksheet to your disk

SESSION 2.2 FORMATTING CELLS, PRINT
SETUP, AND PRINTING

In this session, you will complete the worksheet by formatting it to apply a
more professional look, increase the width of a column to accommodate
longer text entries, insert rows and columns to provide visual boundaries
between worksheet sections, undo worksheet changes, and format groups
of cells with Excel’s AutoFormat command. You will explore how to estab-
lish worksheet headers and footers, set page margins, establish a work-
sheet’s print area, and add cell-level documentation and worksheet-wide
documentation.

STRESS TESTING A WORKSHEET
Using an electronic worksheet to produce results sometimes gives the
worksheet designer a sense that the formulas and results are correct
because the product is, after all, an electronic worksheet. Therefore, the
results must be correct. This is not always the case, and mistakes can creep
in and linger, undetected, for days or months if you don’t examine the
results carefully and test the worksheet to prove its validity. Testing need
not be a long or complicated procedure. You can choose from several test
methods to validate the worksheet’s formulas and results.

making the grade
1. Explain how AutoSum works and what it does.

2. Suppose you select cell A14 and type D5�F5. What is stored in
cell A14: text, a value, or a formula?

3. You can drag the , which is a small black square in the
lower-right corner of the active cell, to copy the cell’s contents.

4. Evaluation of a formula such as �D4�D5*D6 is governed by
order of precedence. Explain what that means in general and
then indicate the order in which Excel calculates the preceding
expression.

5. Suppose Excel did not provide an AVERAGE function. Show an
alternative way to compute the average of cell range A1:B25
using the other Excel statistical functions.

S E S S I O N  2 . 1

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.32



One way to test a worksheet is to enter valid, small numbers in the
input cells and observe the formulas’ computed results. For example, you
can enter 10 into each city’s recycling cells for all three months and then
change each city’s population to 10. If your worksheets’ formulas are cor-
rect the recycling per capita will be 3 across all cities—a result you know is
correct—and the three-month totals display 30 for all cities. Similarly, the
recycling statistical values will all be the same—the minimum, average,
and maximum should display 10.

Entering extreme or limit values into a worksheet’s non-formula cells
is another way to test your worksheet’s formulas. For example, if you enter
zero into the recycling cells for all cities and all months, then all formu-
las—totals, per capita recycling, and statistics by month—should all dis-
play zero.

Finally, you can try out a few test calculations with your calculator and
compare the results with the same values in your worksheet. If the results
jibe, your worksheet formulas are correct.

MODIFYING A WORKSHEET’S APPEARANCE
After testing the worksheet, you and Kelly are satisfied that the worksheet
is correct. However, Kelly wants to modify the worksheet so that it looks
more professional. Cosmetic changes to a worksheet—changes that make
the text and numbers appear different—occur when you format a work-
sheet. While formatting changes the appearance of the results displayed by
text, values, and formulas, formatting never changes a cell’s contents.

Kelly has identified a few formatting changes that will render the
worksheet more professional and easy to read. She wants you to widen the
column containing city names so that they have a bit more space between
them and the population column to the right. Additionally, she wants you
to insert two rows above the Aluminum Can Recycling Contest title and to
insert a blank row between the recycling total row and the row containing
the Minimum recycling values for each month. She also asks you to insert
a blank row between the Maximum values row and the Potential Revenue
row, to make the recycling statistics values display their values with com-
mas and no decimal places, and to display the potential revenue values
with currency symbols and commas. Finally, Kelly wants you to move the
revenue per can value and its label to cells A1 and B1 so that what-if
assumption value is near the top of the worksheet.

Inserting and Deleting Rows

You cannot always anticipate where you will need more columns or rows
in order to make room for omitted cells or to add a blank row for aesthet-
ic reasons. Fortunately, Excel allows you to add rows or columns at any
point and accommodates existing work by moving existing rows to accom-
modate inserted or deleted rows. Likewise, if you insert or delete columns,
Excel automatically moves columns to accommodate them. Inserting rows
or columns follows the same procedure: You select the number of rows or
columns you want to insert and then click the Insert command. After Excel
repositions existing rows or columns to accommodate the insertion opera-
tion, it adjusts all cell references in formulas to reflect the new locations of
cells referenced by the formulas.

Kelly wants you to insert two rows above the worksheet title currently
in row 1.

w w w . m h h e . c o m / i - s e r i e s EX 2.33

EXCEL

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.33



EX 2.34 CHAPTER 2 EXCEL 2.2 FORMATTING CELLS, PRINT SETUP, AND PRINTING

Inserting rows into a worksheet:

1. Click cell A1 and drag the mouse through cell A2 to indicate
the row above which you want Excel to insert two additional
rows

2. Click Insert on the menu bar and then click Rows. Excel
inserts two rows at the top of the worksheet and moves exist-
ing rows down

3. Click cell A11 to prepare to insert a blank row between the
Total row, containing monthly recycling totals, and the
Minimum row

4. Click Insert and then click Rows. Excel inserts the new row 11
(see Figure 2.24)

task reference
Inserting Rows

• Click any cell above which you want to insert a row or select a range of
cells in several rows above which you want to insert several rows

• Click Insert and then click Rows. Excel inserts one row for each row
you selected

Inserting Columns

• Click one or more cells in columns to the left of which you want to
insert one or more new columns

• Click Insert and then click Columns. Excel inserts as many new
columns as there are in the range you selected

row inserted in the
wrong location

click the Undo button to
cancel last operation

F I G U R E  2.24
Inserting three new rows into a
worksheet
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Correcting Mistakes with Edit Undo

The last row you inserted is not where you want it to be. To correct that
error, you can delete the newly inserted row or you can click the Undo but-
ton to cancel the last operation. You can click the row label to the left of
column A to select the entire row. Then, click Delete in the Edit menu to
delete the row. You will find the Undo method helpful in so many other sit-
uations that you decide to use it to cancel the insert row action. Whenever
possible, use the Undo method immediately after you realize that you want
to reverse one or more actions.

Canceling the previous row insertion
action:

1. Click the Undo button on the Standard toolbar (see Figure
2.24). Excel deletes the row you previously inserted

Now you are ready to insert a new row in the correct position—
between the Total and Minimum rows.

Inserting a row into a worksheet:

1. Click cell A12 to prepare to insert a blank row between the
Total row, containing monthly recycling totals, and the
Minimum row

2. Click Insert and then click Rows. Excel inserts the new row—
row 12—and moves all other rows below it down one row

Because it is convenient to place cells in a convenient location when
they are used in what-if analysis, you move the recycling value per can
assumption and its label to cells A1 and A2. That way, anyone who wants
to see the effect of changing the value per can to three cents can locate the
cell quickly and change it easily.

Moving cells to another location in a
worksheet:

1. With the mouse, select the cell range H3:I3, which contains
the value and label you want to move

2. Hover the mouse over cell H3 and slowly move the mouse
toward one of the selected cell range’s edges until the mouse
pointer changes to a four-headed arrow 

3. Click the mouse button and hold it down as you drag the out-
line to cells A1 through B1 (see Figure 2.25)

4. Release the mouse button to complete the move operation.
The value 0.02 and label per can now occupy cells A1 and B1,
respectively
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5. Click any cell to deselect the cell range

Using AutoFormat

Excel’s AutoFormat feature provides you with a wide selection of prede-
fined formats from which you can select to alter the appearance of your
worksheet. Each of the AutoFormat selections in the portfolio of formats
includes a variety of formatting selections including color, fonts, shading,
and lines. AutoFormat automatically adjusts column widths and heights
and selects cell alignment characteristics that yield the most attractive
presentation. Formatting changes to your worksheet such as those
AutoFormat supplies should be one of the last operations you apply to
your worksheet. If you format cells or cell ranges with AutoFormat or do
so manually before you have built a complete worksheet, you frequently
have to reapply formatting to accommodate larger than expected numeric
values requiring cell width or font size adjustments.

Experiment with AutoFormat by formatting rows 3 through 11 of the
recycling worksheet.

Formatting cells with AutoFormat:

1. Select the cell range A3 through G11

2. Click Format on the menu bar and then click AutoFormat.
The AutoFormat dialog box opens and displays the first of

outline indicates drop destination

drop cell range 
address displayed

cells being
moved

F I G U R E  2.25
Moving cells’ contents

task reference
Applying AutoFormat to Cells

• Click the cell range you want to format

• Click Format and then click AutoFormat

• Select the format style from the portfolio of styles in the Table Format
list

• Click OK to select and apply the format you choose

anotherway

. . . to Move Cells’
Contents

Select the cell range you
want to move

Press Ctrl+X to cut the
selected cells

Select the cell range to
which you want to move
the cells

Click Ctrl+V to paste the
cells to their new
location

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.36



w w w . m h h e . c o m / i - s e r i e s EX 2.37

EXCEL

several AutoFormat styles (see Figure 2.26). A dark outline
appears around the Simple format, because it is the currently
selected format

3. Click OK to select and apply the format to the cell range you
selected in Step 1

4. Click any cell to deselect the range. The new format alters a
portion of the Recycle worksheet (see Figure 2.27)

Formatting Cells Manually

Kelly reviewed your work so far and is pleased. She would like the numer-
ic values to contain commas to make their values easier to read. Kelly
would also like you to format the Per Capita column so that the values all
contain two decimal places. The Per Capita values are also difficult to read
because the decimal points aren’t aligned. Finally, Kelly wants the
Potential Revenue row values to include currency symbols so that work-
sheet viewers clearly understand the row contains revenue and not recy-
cling units. You begin by formatting a portion of the worksheet so that
numeric values include commas and no decimal places—whole numbers.

selected format
has dark outline

F I G U R E  2.26
AutoFormat dialog box

F I G U R E  2.27
Worksheet after applying
AutoFormat

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.37



EX 2.38 CHAPTER 2 EXCEL 2.2 FORMATTING CELLS, PRINT SETUP, AND PRINTING

Formatting numeric entries to display
commas and no decimal places:

1. Select the cell range B6 through F15

2. Click the Comma Style button on the Formatting toolbar.
Several cell entries display #######, which indicates the for-
matted value is too wide to display the entire value

3. Click the Decrease Decimal button twice (located on the
Formatting toolbar) to reduce the number of displayed decimal
places to zero. Several cells display values with commas, but
some still display the pound sign (#). You will fix that problem
soon. Ignore it for now

4. Click any cell to deselect the range

Next, reduce the number of decimal places displayed in the Per Capita
column to two.

Formatting numeric entries to display
commas and two decimal places:

1. Select the cell range G6 through G11

2. Click the Comma Style button on the Formatting toolbar. All
values in the Per Capita column display numbers rounded to
two decimal places

3. Click any cell to deselect the range

Finally, format the Potential Revenue column so that the currency
symbol, $, displays and reduce the number of decimal places to zero.

Formatting numeric entries to display the
currency symbol and no decimal places:

1. Select the cell range C17 through E17, which displays the
potential revenue for January through March

2. Click the Currency Style button on the Formatting toolbar

3. Click the Decrease Decimal button twice (see Figure 2.28).
The revenue values display a series of # symbols, indicating
the column is too narrow to display the value

Though it is not yet apparent, the revenue values you just formatted
will display dollar signs and no decimal places. To see the several values in
cells that are currently displaying pound signs, you will have to widen the
columns to accommodate their increased width. You do that next.
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Adjusting Column Width

One way to enhance the appearance of a worksheet is to widen columns.
Widening a column to leave some vertical white space between it and its
neighbor adds to the worksheet’s readability. Several columns in the
Recycling worksheet must be widened in order to view the values. The col-
umn containing city names is a little narrow also.

There are several ways to alter a column’s width. You begin by clicking
the column heading—the letter at the top of a column—or drag the point-
er to select a series of contiguous columns and then use the Width com-
mand in the Format menu to select a width. Alternatively, you can move
the mouse to the dividing line on the right side of any selected column
header. When the pointer changes to a resize arrow (a double-headed
arrow), you can drag the dividing line to the right to increase the column’s
width or drag it to the left to decrease the column’s width. Moving the
mouse pointer to the column heading dividing line, you can double-click
the right-side dividing line to make the entire column as wide as the widest
entry plus one character.
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the repeating symbol #
indicates the cell is too
narrow to display the results 

F I G U R E  2.28
Worksheet after applying
numeric formats

task reference
Modifying a Column’s Width

• Select the column heading(s) of all columns whose width you want to
change

• Click Format, point to Column, and click Width

• Enter the new column width in the Column Width text box and click
OK, or click AutoFit Selection to make the column(s) optimal width
as wide as the widest entry in the column

or

• Double-click the right edge of the column heading line to make the
column(s) optimal width(s) as wide as the longest entry in the
column(s)

or

• Drag the column heading dividing line of any one of the selected
columns to the left to decrease the column width or to the right to
increase the column width
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Kelly wants you to increase the column widths of columns A through
F to display the city names and values completely.

Increasing the width of column A:

1. Move the mouse pointer to the A column header and move it
slowly to the right edge of the column heading dividing line.
The pointer changes to a resize arrow 

2. Click and drag the column heading A dividing line to the
right until the pop-up ScreenTip indicates the width is 11 char-
acters or more

3. Release the mouse button

Next, you will increase the width of columns B through F in one oper-
ation. You want the columns to be wide enough to accommodate the
widest numeric value so that the repeated pound signs disappear and the
computed recycling and statistical values appear in their place.

Optimizing the width of several columns
at once:

1. Click column heading B and drag the mouse through col-
umn heading F and release the mouse. This selects the five
columns whose width you want to alter

2. Move the mouse pointer to the heading dividing line between
any two selected columns. The pointer changes to a resize
arrow

3. Double-click the column heading dividing line to make the
selected columns optimal width (see Figure 2.29)

4. Click any cell to deselect the columns. Notice that all the com-
puted results display in the worksheet. The Potential Revenue
row values contain commas and currency symbols, just as
Kelly wanted

ex501

selected columns
whose width
is changed

F I G U R E  2.29
Optimizing columns’ widths
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You learned in Chapter 1 how important page headers and footers are
in identifying printed output. Kelly wants you to add a header with the title
“Aluminum Can Recycling Contest Results” centered on the page. In addi-
tion, she wants the worksheet footer to contain your first and last names to
identify the worksheet’s author.

Creating a worksheet header and footer:

1. Click View on the menu bar and then click Header and
Footer

2. Click Custom Header, click in the Center section, type
Aluminum Can Recycling Contest Results, and click OK

3. Click Custom Footer, click in the Center section, type your
first and last names, and click OK

4. Click the Print Preview button on the Standard toolbar to
preview the worksheet complete with the new header and
footer

5. After you have examined the output to ensure that it looks as
you expected, click the Close button to close the Preview win-
dow and return to the worksheet window

The output looks great. Save the worksheet and then print it so that
Kelly can scan the worksheet before you make it available to the public.

Printing a worksheet:

1. Click File on the menu bar

2. Click Print

3. Click OK to print the worksheet

ADJUSTING PAGE SETTINGS
You give the worksheet printout to Kelly so that she can comment on it.
She is pleased with your work and suggests that you change the left mar-
gin to 1.5 inches and set the top, bottom, and right margins to one inch.
She wants another printout that contains only rows 3 through 11 of the
worksheet.

Setting the Print Area

Unless you specify otherwise, Excel prints the entire worksheet, including
any incidental or scratch areas of the worksheet you may have used. Many
times, you want to print just a selected part of a worksheet. To restrict the
print output to part of a worksheet, you select the area to be printed and
then execute the Excel Set Print Area command to tell Excel the print
range.
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Setting a worksheet’s print area:

1. Drag the mouse pointer through the cell range A3:G11 to
select it

2. Click File, point to Print Area, and then click Set Print Area

3. Click File, and then click Print Preview to examine the output
prior to printing it. Notice that the statistics do not appear in
the output. Neither does the value per can assumption cell in
row 1 of the worksheet

4. Click Close to return to the worksheet, and click any cell to
deselect the area

To print the entire worksheet after you have set the print area, you
must remove the print area before printing the worksheet. A worksheet’s
print area is stored with the worksheet, so Excel remembers if a print area
is set or not. Remove the print area by clicking File, point to Print Area,
and click Clear Print Area. Once you remove the print area, the entire
worksheet will print.

Setting Print Margins

Print margins define the area of a printed page in which a worksheet
appears. The left, right, top, and bottom margins define the area. The left
margin defines the size of the white space between a page’s left edge and
the leftmost edge of the print area. Similarly, the right margin defines the
white space between the print area’s rightmost position and the right edge
of a printed page. Header information appears within the top margin,
which is the area between the top of the page and topmost edge of the
print area. The bottom margin is the area at the bottom of the page
between the bottommost portion of the print area and the bottom edge of
the page. A worksheet’s page footer, if any, appears in the bottom margin.

You can set each worksheet’s page margins independently using sever-
al techniques. Set the margins by executing the Page Setup command in
the File menu and clicking the Margins tab. Alternatively, you can click the
Margins button in the Print Preview window and move any margin by
dragging the dashed line representing each margin.

Setting a worksheet’s print margins:

1. Click File on the menu bar

2. Click the Page Setup command. The Page Setup dialog box
opens

3. Click the Margins tab

4. Type 1.5 in the Left spinner control box. This sets the left mar-
gin to 1 1/2 inches

5. Type 1 in the Top, Right, and Bottom spinner control boxes
(see Figure 2.30). This sets the margins to 1 inch
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6. Click the Print Preview button on the Standard toolbar to
preview the worksheet with its changed print margins

7. Click Close to close the Print Preview window

You have made a large number of changes to the Aluminum Can
Recycling Contest worksheet since you last saved it. It is time to save your
work so that you preserve all the changes.

Saving your worksheet:

1. Click File on the menu bar

2. Click Save

DOCUMENTING THE WORKBOOK
It is always smart to document your work so that the next person assigned
to modify or extend your work can easily and quickly understand the pur-
pose and use of your worksheet. Besides external documentation such as
printouts of worksheet formulas and your own notes, you can create inter-
nal documentation. As you recall, the first page of a workbook can contain
extensive documentation including the author’s name, the dates of major
changes to the worksheet, and instructions on how to input data and use
the worksheet. Small simple worksheets such as the Recycling worksheet
require simple instructions. Larger more complex worksheets require
more extensive instructions including which cells comprise the input area,
which cells contain formulas whose results depend on the input area(s),
and which workbook worksheets contain additional information or
instructions.

line corresponds to the 
active spinner box—
the one with the 
mouse insertion point

F I G U R E  2.30
Adjusting print margins
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One valuable but often overlooked source of documentation is the
Properties dialog box found on the File menu. The Properties dialog box
contains several text boxes that you can fill in with helpful information
including the fields Title, Subject, Author, Manager, Company, Category,
Keywords, and Comments. A workbook’s creator can enter his or her name
in the Author field. Another way to document a workbook is to include
internal notes on individual worksheet cells. Called comments, these
worksheet cell notes are particularly helpful to indicate special instruc-
tions about the contents or formatting of individual cells.

Setting File Properties

Kelly wants you to fill in the Title, Author, and Manager fields of the
Property dialog box to record within the worksheet these important pieces
of documentation.

Documenting a worksheet using the
Properties dialog box:

1. Click File on the menu bar, click Properties, and click the
Summary tab, if necessary

2. In the Title text box, type Aluminum Can Recycling
Contest and then press the Tab key twice to move to the
Author text box

3. Type your first and last names in the Author text box and then
press the Tab key

4. In the Manager text box, type Kelly Allison (see Figure 2.31)

5. Click OK to close the Properties dialog box

F I G U R E  2.31
Completed Properties dialog box
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Adding Cell Comments

Kelly also wants you to place a note in cell A1 indicating that the two-cent
per can recycling value is approximate. This will help others who use the
worksheet in the future to understand that the value is a variable that any-
one can change to observe changes in potential revenue from recycling. In
cell B5, Kelly wants you to place a comment indicating the source of the
population numbers—the World Wide Web.

Cell comments are analogous to sticky notes on which you can write
reminders and attach to paper. Like sticky notes, cell comments can
remind a worksheet developer or user about special conditions attached to
a worksheet or cell, explain any restrictions on user input values, or pro-
vide an outline of the steps required to complete an unfinished worksheet.

Create the cell comment that Kelly asked you to insert in cells A1
and B5.

Insert comment in cells:

1. Click cell A1 to make it the active cell

2. Click Insert and then click the Comment command. The com-
ment text box opens

3. If the comment text box contains text, such as a user or com-
puter name, delete the text.

4. Type Kelly Allison: (type a space after the colon)

5. Continue by typing the text Per can value is an approxima-
tion. Change it for revenue what-if analysis. (Be sure to
include a period to end the comment’s second sentence)

6. Click cell B5, click Insert, and click Comment

7. Repeat steps 3 and 4

8. Type Population figures obtained from the World Wide
Web. and click any cell besides cell B5 to complete the com-
ment and close the text box

9. View the hidden comment by hovering the mouse pointer over
cell A1. The Comment text box pops up (see Figure 2.32)

10. Hover the mouse pointer over cell B5 to view that cell’s
comment

task reference
Inserting a comment

• Click the cell to which you want to add a comment

• Click Insert and then click Comment to display the comment text box

• Type the comment

• Click any other cell to close and store the comment
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11. Save your worksheet to preserve the changes you have made
in this chapter

12. Close Excel

To delete a comment, select the cell containing the comment you wish
to delete. Then click Edit on the menu bar, point to Clear, and click
Comments to delete the selected cell’s comment.

SESSION 2.3 SUMMARY

Enter a value or text into an Excel cell by selecting the cell and typing the
value or text. Excel formulas such as �D3�B4 begin with an equal sign to
indicate the entry is not text. Excel provides AutoSum to automatically
build a SUM function whose argument is an adjacent, contiguous row or
column of values or expressions resulting in values. When necessary, you
can adjust the AutoSum cell range suggested by Excel.

Excel provides standard mathematical operators of exponentiation,
multiply, divide, add, and subtract. The mathematical operators conform
to a precedence order that dictates which parts of an expression are evalu-
ated before other parts. When you want to alter the order in which Excel
evaluates expressions in a formula, you can use parentheses to group parts
of the formula. For example, you use parentheses to cause Excel to evalu-
ate the expression A1�B2 first in the formula �B17*(A1�B2) even though
addition has lower precedence than multiplication.

Three other important statistical functions Excel provides are MIN,
AVERAGE, and MAX. MIN determines the smallest value of its arguments.
AVERAGE calculates the average value of its argument list. MAX displays
the largest value in its list of arguments. Similar to other functions, these
three statistical functions ignore empty cells or text cells in argument cell
ranges. You can write arguments in the argument list in any order.

Most spreadsheet projects include formulas that are similar to one
another. Take advantage of Excel’s ability to quickly create formulas by
copying a formula to other cells. When you copy a formula such as
�SUM(A1:A4) to another cell, Excel creates a copy of that formula and
adjusts all cell references to reflect the copied formula’s new position. Cell
adjustment is automatic when you use relative cell references. When you
do not want Excel to adjust selected cell references in a copied formula,
then you must use either mixed or absolute cell references. Moving a cell’s
contents to another location has no effect on the formula—all cell refer-
ences remain unaltered.

comment text box

red triangle indicates cell
contains a comment

F I G U R E  2.32
Viewing a cell comment
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Insert additional rows or columns into a worksheet wherever needed.
Select a cell above which you wish to insert additional rows or to the left
of which you wish to insert additional columns and then execute the Insert
Rows or Insert Columns command. Excel automatically adjusts all formu-
las affected by the Insert procedure to reflect the new location of refer-
enced cells, regardless of whether the cell references are relative, mixed, or
absolute. Deleting one or more rows or columns is equally simple. Select
the row(s) or column(s) to delete and then execute the Edit menu Delete
command. When you delete cells, Microsoft Excel removes them from the
worksheet and shifts the surrounding cells to fill the space.

Formatting modifies the appearance of cells, but not their contents.
AutoFormat provides a predefined set of formats you can apply to a cell
range, or you can format cells individually with the Format menu. Correct
any mistakes, including unwanted formatting, by executing the Undo com-
mand in the Edit menu. If pound signs (#) appear in a cell indicating a
column is too narrow to display the formatted numeric value, widen the

w w w . m h h e . c o m / i - s e r i e s EX 2.47

EXCEL

making the grade
1. Briefly describe how you might test a worksheet to determine

whether its formulas are correct.

2. If you make a mistake in entering a formula, you can reverse the
operation by executing the _______ command on the _______
menu.

3. Which of the following is the correct formula to add cells B4 and
A5 and multiply the sum by cell C2?
a. �C2*B4�A5
b. �B4�A5*C2
c. �(B4�A5)*C2
d. �B4�(A5*C2)
e. none of the above is correct

4. Suppose cell A5 contains the formula �C1�D12 and you move
that cell’s contents to cell C6. After the move, what is the formula
in cell C6?
a. �E2�F3
b. �C1�D2
c. �B1�D12
d. �none of the preceding

5. Modify the recycle worksheet, Recycle.xls, in the following
ways. In cell G11 write a formula that will compute the overall
average per capita values stored in cells G6 through G10. Move
the Total label in cell B11 to cell A11. (You notice that moving a
cell’s contents removes the source cell’s formatting. You will
restore that in a moment.) Type a formula in B11 that will
compute the total population of the five cities in the contest.
Write a formula in cell F17 to sum the potential revenue row. In
F16, type Total Revenue to identify the summation of revenue.
Clear the Print Area so that the entire worksheet prints. Select
the cell range A3:G11 and reformat it with the AutoFormat
Simple style. Click cell A1 to deselect the cell range. Save the
worksheet under the name Recycle2.xls. Print the worksheet
and then print the worksheet formulas.

S E S S I O N  2 . 2
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column or columns by dragging the column heading dividing line located
on the right side of the column’s label.

Before printing a worksheet, preview your output. If necessary, adjust
a worksheet’s print margins by executing Page Setup in the File menu and
clicking the Margins tab. Set a worksheet’s Print Area to specify printing
less than all the non-empty worksheet cells. Document a workbook by fill-
ing in the text boxes found in the Properties dialog box that you access
from the File menu. In addition, you can use comments to attach internal
notes to worksheet cells to explain any unusual circumstances or remind
the worksheet user or developer about the content of selected cells.

MOUS OBJECTIVES SUMMARY

• Create formulas containing cell references and mathematical
operators (MOUS Ex2002-5-1)

• Write functions including Sum, Average, Max, and Min
(MOUS Ex2002-5-2)

• Differentiate between absolute, mixed, and relative cell reference
(MOUS Ex2002-5-1)

• Adjust column widths (MOUS Ex2002-3-2)

• Set a print area (MOUS Ex2002-3-7)

• Move text, values, and formulas (MOUS Ex2002-1-1)

• Insert and delete rows and columns (MOUS Ex2002-3-2)

• Format cells (MOUS Ex2002-3-1)

• Create cell comments (MOUS Ex2002-7-3)

EX 2.48 CHAPTER 2 EXCEL 2.3 SUMMARY
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EXCEL

task reference roundup
Task Location Preferred Method

Writing formulas EX 2.00 • Select a cell, type 5, type the formula, press Enter

Modifying an AutoSum EX 2.00 • Press an arrow key repeatedly to select leftmost or topmost cell in 
cell range by pointing range, press and hold Shift, select cell range with arrow keys,

release Shift, press Enter

Writing a function EX 2.00 • Select a cell, click Paste Function, click a function category, click a 
using the Paste function name, click OK, complete the Formula Palette dialog box, 
Function button click OK

Copying and pasting EX 2.00 • Select source cell(s), click Edit, click Copy, select target cell(s), click 
a cell or range of cells Edit, click Paste

Copying cell contents EX 2.00 • Select source cell(s), drag the fill handle to the source cell(s) range, 
using a cell’s fill handle release the mouse button

Changing relative EX 2.00 • Double-click the cell, move insertion point to the cell reference, 
references to absolute press F4 repeatedly as needed, press Enter
or mixed references

Moving cells’ contents EX 2.00 • Select the cell(s), move the mouse pointer to an edge of the selected
range, click the edge of the selected cell or cell range, drag the
outline to the destination location, release the mouse

Spell-checking EX 2.00 • Click cell A1, click the Spelling button, correct any mistakes, 
a worksheet click OK

Inserting rows EX 2.00 • Click a cell, click Insert, click Rows

Inserting columns EX 2.00 • Click a cell, click Insert, click Columns

Applying AutoFormat EX 2.00 • Select a cell range, click Format, click AutoFormat, select a format 
to cells style, click OK

Modifying a column’s EX 2.00 • Select the column heading(s), click Format, point to Column, click 
width Width, type column width, and click OK

Inserting a comment EX 2.00 • Click a cell, click Insert, click Comment, type a comment, and click
another cell
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chapter two

CROSSWORD PUZZLE

Across

3. A mathematical that represents an
arithmetic operation

6. Type of internal documentation, or note,
attached to a cell

8. The finder color codes cells refer-
enced by the formula you are editing.

10. This dialog box contains fields such as Title
and Subject that you fill in to provide addi-
tional documentation

Down

1.1.1. General name for cells to which other cells
are copied

2.2.2. This list is enclosed in parentheses
4.4.4. A cell is a cell upon which a formu-

la depends
5.5.5. General name for cells that are being copied
7.7.7. This value occurs when you make a mistake

writing a formula
9.9.9. When you do this to cells, it changes their

appearance but not their contents
11.11.11. Rules governing the way you write Excel

functions
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FILL-IN

1. The function totals one or more cells.

2. While writing a formula, you can use a technique called to select a cell range rather
than using the keyboard to type the cell range.

3. order determines the sequence in which Excel evaluates expressions containing
addition, subtraction, multiplication, division, or exponentiation.

4. If you copy a formula such as �B4�C9, Excel does what to the copied formula’s cell references?

5. There are three types of cell references: relative, , and .

6. The Standard toolbar button helps you write a function and fill in the arguments.

REVIEW QUESTIONS

1. Suppose cell D1 contains 0.14, the proposed salary percentage increase for next year, and cells B5
through B8 contain current salaries. Next year’s increased salaries—computed from formulas—are
in cells C5 through C8. All other cells are empty. You write the formula �B5*(1+D1) in cell C5 and
then copy that formula to cells C6 through C8. Explain, briefly, what is wrong with the original for-
mula in cell C5 and how you would correct it before re-copying the formula.

2. If Excel did not have an AVERAGE function, how would you write an expression to compute the
average of cells A5 through A10 using other Excel functions?

3. Describe in two or three sentences what Excel does to modify copied formulas.

4. Briefly describe what Excel does, if anything, to the contents of a formula that you move to another
location. What happens, if anything, to formulas that refer to a moved cell?

5. Does formatting a cell alter its contents? Explain.

6. Experiment with Excel to answer this question. Describe what happens when you enlarge or nar-
row a column having an unformatted cell whose formula is �1/7?

CREATE THE QUESTION

For each of the following answers, create an appropriate, short question.

ANSWER QUESTION

1. Builds a SUM function automatically

2. Provides a variety of predefined formats

3. Do this to view worksheet output before
printing

4. Set this to restrict the cells that Excel prints

5. This command can reverse a mistake you
made in the previous operation

6. Dragging this object copies formulas to other
cells
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chapter two

practice
1. Managing Employees’ Work Hours

You are a project manager for Wexler’s Tool and
Die Manufacturing and manage a group of five
people. Each employee in your group has a differ-
ent hourly rate, and you must record on a weekly
basis the number of hours each employee works,
the total wages per employee, and percentage of
the whole group’s wages that each employee’s
weekly wage represents. Keeping the information
on a worksheet is the most efficient way to record
and report employee activity. Alan Gin, the com-
pany’s Chief Operating Officer, wants you to pre-
pare an Excel worksheet to report your group’s
weekly hours and gross wages. You create a
worksheet to track the hours and wages.

1. Open the workbook ex02Wages.xls and
save it as Wages2.xls

2. Review the Documentation sheet and then
click the Sheet2 tab to move to that work-
sheet

3. Widen column A so that all the employees’
names are entirely visible

4. Insert two new rows above row 1: Click cell
C1, drag through cell C2, and release the
mouse. Click Insert on the Menu bar and
then click Rows

5. Click cell A1 to deselect the range and type
Employee

6. Click cell B1, type Rate, click cell C1, type
Hours, click cell D1, type Wages, click cell
E1, and type Percentage

7. Type the following employee hours in the
corresponding cells:
Cell B3: 25
Cell B4: 40
Cell B5: 30
Cell B6: 20
Cell B7: 35

8. Click cell D3, type �B3*C3, the formula to
compute Bushyeager’s wage, and press
Enter

9. Copy Bushyeager’s wage formula to the cell
range D4:D7

10. Click cell B8 and type Totals
11. Select cell range C8:D8 and click the

AutoSum button

12.12.12. Click cell E3 and type the formula that rep-
resents the employee’s percentage of the
total wages: �D3/D$8*100

13.13.13. Copy the formula in cell E3 to the cell range
E4:E7

14.14.14. Select cell range A1:E8, click Format, click
AutoFormat, select the Simple format, and
click OK

15.15.15. Select cell range E3:E7 and click the
Decrease Decimal button enough times
to reduce the displayed percentages to two
decimal places

16.16.16. Click cell A10 and type your first and last
names

17.17.17. Set the left, right, top, and bottom margins
to two inches

18.18.18. Either execute Print or execute Save As,
according to your instructor’s direction

2. Creating an Invoice

As office manager of Randy’s Foreign Cars, one of
your duties is to produce and mail invoices to
customers who have arranged to pay for their
automobile repairs up to 30 days after mechanics
perform the work. Randy’s invoices include parts,
sales tax on parts, and labor charges. State law
stipulates that customers do not pay sales tax on
the labor charges. Only parts are subject to state
sales tax. State sales tax is 6 percent. Create and
print an invoice whose details appear below.

1.1.1. Open the workbook ex02Randys.xls on
your student disk in folder Ch02

2.2.2. Insert rows in which you can enter the cus-
tomer’s name and address: Click cell A5,
drag the mouse down through cell A8, and
release the mouse

3.3.3. Click Insert and then click Rows
4.4.4. Type the following in the indicated cells:

cell A5: Customer:
cell B5: Craig Shaffer
cell B6: 21121 Bluff Place
cell B7: Lincoln, NE

5.5.5. Click cell E11 and type the extended price
(unit price times quantity) formula:
�A11*D11

6. Select E11 and drag its fill handle to copy
the formula in El1 to cells E12 through E15

w
w

w
.
m

h
h

e
.
c

o
m

/
i-

s
e

r
ie

s

haa70313_EXch02.qxd  10/12/01  3:58 PM  Page 2.53



EX 2.54

chapter twohands-onprojects
L

E
V

E
L

 
L

E
V

E
L

 
T

H
R

E
E

T
H

R
E

E

1. Building a Product Comparison
Worksheet

Jacob’s Fine Stationers carry different lines of
fine pens. You have been asked to help them fig-
ure out the profits the store generates from pen
sales. The information is as follows: The store has
20 Stylo pens in stock, which sell for $27 each
and cost the store $8 each. There are 15 Royal
pens in stock, which sell for $45 and cost the
store $12. There are 50 Hans pens in the store,
which sell for $78 and cost the store $50. There
are 6 Tower pens in stock, which sell for $120 and
cost the store $60.

Create a spreadsheet with the following col-
umn labels: Pen, Quantity, Cost, and Price.
Enter the pen names Stylo, Royal, Hans, and
Tower in the column headed by the label “Pen.”
Write formulas below the Quantity, Cost, and
Price columns that indicate the minimum, aver-
age, and maximum values for Quantity, Cost, and
Price. Create a column labeled Profit per Pen.
Create a formula and copy it to fill in these cells
with the difference between price and cost. Create
a column labeled Total Profits per Pen. Fill the
cells in this column with formulas that multiply
profit per pen by quantity in stock for each pen.
Add a formula below the last entry in the Total
Profits per Pen to compute total profits for all
pens, assuming all pens in stock sell.

Widen any columns as needed to view
column-top labels. Insert two rows at the top of
the worksheet and type your first and last names.
Select all numeric cells and then click the
Increase Decimal button enough times to display
two decimal places for numbers. Print the work-
sheet.

Change a cell in the worksheet to answer this
question: If the store decides not to sell any of
their Royal pens, how will total profits be affect-
ed? (Type 0 in the Quantity cell for the Royal
pen.) Add text to the worksheet indicating that
this shows what happens to the total profits if
Royal pens are not sold. Print the worksheet.

2. Writing a Payroll Worksheet

Bateman Leisure Properties wants you to create
a payroll worksheet that provides management

with an overview of the hourly workers’ pay and
taxes. Alicia Hernandez, the human resources
manager, provides you with a preliminary work-
sheet containing employee names—there are
quite a few—column labels, and some tax rate
information. She asks you to complete the work-
sheet and save it under a new name when you are
done. She would like you to document the tax
rate cell and the overtime rate cell with short
comments. In preparation for this exercise, open
the workbook ex02Payroll.xls stored on your
student disk in the folder Ch02 (see Figure 2.33).

Start by writing a formula for Patti
Stonesifer’s gross pay. Compute gross pay as reg-
ular pay plus overtime pay. Regular pay is the
employee’s pay for up to 40 hours and is com-
puted as hourly rate times hours worked.
Overtime pay is paid for overtime hours—any
hours over 40. Compute overtime pay at an
hourly rate that is 1.5 times the regular rate times
the overtime hours. Be sure to reference cell C2 in
the gross pay formula using a mixed cell refer-
ence form, C$2 instead of using the constant 1.5.
When her gross pay formula is correct, copy it
down through the remaining employees’ gross
pay cells.

In the Federal Tax column, write one formula
and copy it to the other employees’ rows. Federal
tax is gross pay times the federal tax rate found in
cell C1. Be sure to reference cell C1 using the

challenge!
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Payroll worksheet
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chapter two

on the web
1. Selecting an Online Broker

Erik Engvall is trying to decide which online bro-
kerage firm he should use for trading stocks.
After some research, he came up with the follow-
ing list of five online brokerages that are highly
rated. The brokerages are Ameritrade, Charles
Schwab & Co., Datek Online Brokerage Services,
DLJ Direct, and Fidelity. Figure 2.34 shows the
Web addresses of each of these online brokers. To
help Eric, you will use the Web to lookup how
much each service charges for stock transactions.
The annual fees vary and are sometimes difficult
to find. Assume that the annual charges are as fol-
lows: Ameritrade—$49, Charles Schwab—$35,
Datek—$20, DLJ Direct—$40, and Fidelity—$50.
(The preceding fees are contrived costs—the list-
ed online brokers have different annual fees or
none at all.) Arrange this information in columns,
with each brokerage firm in a separate row.

Label the columns the following way:
Company, Price per Trade, and Annual Fee. In
a cell, enter 4, which is the number of brokerage
transactions per month that Erik estimates he
executes with a broker. (That number will be the
what-if analysis value you can change to deter-
mine the overall cost differences between the bro-
kers you have selected.) Write formulas to
compute the minimum, average, and maximum
charge per transaction and formulas to compute
the minimum, average, and maximum annual
fee. Create a column labeled Total Cost per
Month and label another column to the right of
the monthly cost column called Total Yearly
Cost. Beneath the Total Cost per Month column,
write a formula for each brokerage indicating the
cost for four transactions (refer to a cell contain-
ing 4 that you created earlier). Write formulas for
each brokerage row indicating the total annual
cost, assuming Erik continues to execute four
transactions per month for the year. Remember
to add the annual fee.

You forgot to include another important bro-
kerage, E*Trade. Insert a new row between DLJ
Direct and Fidelity and enter E*Trade under the
Company column. Complete the information in
the E*Trade row including Price per Trade.
Assume they do not charge an annual fee. Copy
formulas from DLJ Direct to complete E*Trade’s
missing formulas.

Use the Increase Decimal button on the
Formatting menu to cause all numeric entries to
display two decimal places. Widen columns as
necessary so all entries including brokerage
names and column labels display completely.
Place your name in your worksheet to identify it
and then print the worksheet. Save your work-
sheet in the Ch02 folder as Brokerage2.xls.
Based on this information, which online broker is
the least expensive?
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Brokerage Web addresses

Brokerage Web Address

Ameritrade wwwwwwwww.ameritrade.com/.ameritrade.com/.ameritrade.com/

Charles Schwab wwwwwwwww.schwab.com/.schwab.com/.schwab.com/

Datek wwwwwwwww.datek.com/.datek.com/.datek.com/

DLJ Direct wwwwwwwww.dljdir.dljdir.dljdirect.com/ect.com/ect.com/

E*Trade wwwwwwwww.etrade.com/.etrade.com/.etrade.com/

Fidelity wwwwwwwww.fidelity.fidelity.fidelity.com/.com/.com/
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1. Investigating E-Commerce Service
Providers

Green Gardens is a one-stop gardening store
located in Lincoln, Nebraska. They have been a
successful brick-and-mortar store for over 22
years, but their owner, Orlando Madrigal, wants to
create an online store that will complement their
existing store. Because they do not have room nor
the expertise to buy computing equipment and
software to create an online store, Orlando wants
to locate a commerce service provider (CSP) to
host the store and provide a complete menu of
online services. The CSP provides computer hard-
ware, commerce software, and merchant account
processing (to process credit cards). There are sev-
eral hosting plans available, and each one offers
the same basic service. Orlando wants you to find
a least-cost provider.

Your investigation reveals that most CSPs
charge a one-time setup fee when you signup for
their service, monthly store rental fee to pay for
disk space, and transaction fees charged when a
customer submits his or her credit card to pay for
a purchase. You have found four representative
CSPs and want to create a worksheet to compare
your costs. Orlando estimates that the online store
can sell approximately 10,000 items each month
for the first year. Each sale, he estimates, will aver-
age $50. Armed with those sales assumptions, you
build a worksheet to compare CSP costs.

Figure 2.35 shows the partially complete
worksheet. You are to complete the sheet by fill-
ing in formulas for the estimated annual cost, the
minimum annual cost, and the six statistics
showing the minimum, average, and maximum
setup fees and monthly rental fee.

Begin by opening the E-Commerce worksheet
ex02E-Merchant.xls in the folder Ch02 on your
student disk. Save the file under the name E-
Merchant2.xls. Annual costs consist of the sum
of the one-time setup fee (for the first year),
twelve times the monthly rental fee, and the
transaction costs. The transaction costs consist of
a fixed per-transaction charge, shown in Column
D of Figure 2.35, and a percentage charge for
each transaction. For example, Yoddle charges 15
cents for each transaction plus 2.1 percent of the
transaction value. In other words, Yoddle charges
a transaction cost for selling one $10 garden
implement of $0.15 � 0.021 * 10, or a total of
$0.36. The four formulas for estimated annual
cost should reference the monthly transactions
value in cell B1 and the average transaction value,
$50, in cell B2.

Print the worksheet and print the worksheet
formulas. Based on Orlando’s transaction volume
and per-transaction value assumptions, which
CSP is the least expensive? Which one is the most
expensive?

e-business
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write a formula forwrite a formula forwrite a formula for
minimum annual
cost

write formulas write formulas write formulas 
for estimatedfor estimatedfor estimated
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F I G U R E  2.35
E-Commerce hosting cost comparison
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chapter two

around the world
1. Comparing Living Expenses Around
the World

What does it cost to live for a month in a foreign
country? You’ve been considering living in
Europe or South America for a month next sum-
mer and want to know the total cost of living
abroad. Costs include an apartment locator
agency fee, one month’s rental charges, the cost of
food, utilities, transportation to the foreign coun-
try, and transportation costs within the country
for the month. Using the Web, research the cost
of renting a one-bedroom apartment in Florence
(Italy), Paris, Buenos Aires, and Santiago. Include
cell comments for each city indicating the
source—Web URL or other reference—for your
rental cost information. Document the workbook
by entering information in the Properties dialog
box. Print the worksheet.
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Besides providing pet sitting services, Pampered

Paws has a complete line of pet products. Grace

Jackson, the company founder and owner, wants

to compare the profitability of five different dog

food products she’s interested in selling. There are

several costs associated with purchasing dog food

in bulk. A wholesaler, from which Grace purchases

the dog food, charges a fixed order fee of $100, a

one-time fee charged for each order any customer

places with the wholesaler. Bags of dog food costs

vary, depending on brand. Shipping costs $0.10

per pound, and the shipper charges $25 to deliver

the product to the store. Figure 2.36 shows

Pampered Paws’ cost and the retail price

Pampered Paws can charge for each of the five

dog food products in 10-pound bags.

Create a worksheet showing the total cost of

each of the products if Grace orders 50 bags of

each of the five products. Compute the total profit

Grace’s store can realize if she sells 50 bags of each

of the products. Remember to include the shipping

and delivery charges in your calculations. Figure

2.37 displays one way you might organize your

worksheet. Wherever the notation xxxxx appears

in the worksheet, you should create a formula.

running project
Pampered Paws
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F I G U R E  2.36
Dog food cost comparison

Wholesale Retail 
cost per price per

Brand bag bag

Eukanuba 16.09 22.99

Iams 12.71 16.95

Nutro 12.67 19.49

Pro Plan 11.01 18.99

Vita Rx 13.93 16.99

F I G U R E  F I G U R E  F I G U R E  2.37
Example dog food comparison
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7. Click cell E17, drag the mouse down to cell
E18, release the mouse, click Insert, and
then click Rows

8. Click cell D17 and type Subtotal. Click cell
D18 and type Tax. Click Cell D24 and type
Subtotal, and click cell D26 and type Total

9. Widen column C by moving the mouse to
the dividing line between columns C and D.
When the mouse pointer changes to a resize
arrow, double-click the mouse

10. Click cell E17 and type �SUM(E11:E15)
11. Click cell E18 and type �E17*B1
12. Click cell E24 and type �D21+D22
13. Click Cell D26 and type

�SUM(E17,E18,E24)

tip: Typing commas between the single-cell
references allows you to sum cells that are not
adjacent to one another

14. Click cell E11 and drag through cell E26 to
select the cell range

15. Click once the Increase Decimal button
on the Formatting toolbar

16. Select cell range A2:E26 and then click
File, Print Area, Set Print Area

17. Click cell D5, type your first and last names,
and save the worksheet as Randys2.xls

18. Either Print the worksheet or execute Save
As, according to your instructor’s direction

runover text from EX 2.53
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mixed reference, C$1. Otherwise, you will not get
the correct answer. Write a formula for net pay,
remembering that net pay is gross pay minus fed-
eral tax (in this example). Copy the net pay for-
mula to other employees’ cells.

Next, widen columns B and C so that all
names and tax rates are completely visible. Add a
blank row between the column labels and the first
employee row. Select the Federal Tax Rate value
stored in cell C1 and type this comment: This is a
flat tax rate for experimentation. Click the
overtime rate cell and type the comment Normal
overtime rate is 1.5 times regular rate. Change
this value to review overall changes to gross
pay. (If the comments remain visible after you
press Enter, you can make them disappear by
clicking Tools on the menu bar, clicking Options,
clicking the View tab, and clicking the Comment
indicator only option button in the Comments
section.) Select all cells in the Gross Pay, Federal
Tax, and Net Pay columns displaying values, click
the Decrease Decimals button once, and then
click the Increase Decimal button once to dis-
play two decimal places for all selected cells.

Create a header in page setup, placing your
name in the worksheet header (in the Center sec-
tion), and then print the worksheet. Print the
Gross Pay, Federal Tax, and Net Pay formulas for
all employee rows. (Hint: Check the Formulas
option on the View tab of the Options dialog box.
Set the print area to include only the three
columns containing formulas.). Save the work-
sheet under the name Payroll2.xls.

runover text from EX 2.54
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